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Introduction to IQforms 
 
IQforms enables users to process forms, barcode coversheets and checks and export various data from 

those documents into ImageQuest. IQforms licensing dictates which processing options are available to 

the customer. 

The IQforms solution includes the IQforms Designer for form template design and management, and the 

IQforms Service which handles forms processing and manages form configurations. 

Licensing Components 
IQforms licensing is broken down into four separate modules, each of which can operate independently: 

• Form Templates (created with the Designer) 

• Barcode Coverpages 

• Checks 

• KeywordForms 

These modules are described in this user guide and licensing is managed in IQadministrator (see the 

IQadministrator Guide). Please contact Informa Sales with any questions regarding the modules. 

System Requirements 
 
The IQforms Designer and IQforms Service can both be installed on the same server or workstation, but 
it is recommended that the IQforms Designer be installed on a client workstation and the IQforms 
Service be installed on the ImageQuest server. 

IQforms Designer 

• Microsoft .Net Framework version 4.8  

• Windows 10  
 

IQforms Service  

• Microsoft .Net Framework version 4.8 
• Windows Server 2012 R2, Windows Server 2016, Windows Server 2019, Windows Server 

2022 
 
Additional requirements: 
 

• ImageQuest 15.7 Server 

• At least one Document Type and attribute defined in ImageQuest 
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Installation 
 
IQforms can be installed on any PC on the network. There are two installation files that need to be run, 

Designer.msi and Service.msi. Designer is also known as “FormAssist” and it allows users to design a 

form template for use with IQforms.  The IQforms Service is a Windows service that monitors specific 

folders for form images to be processed and evaluates all pages to extract the form data. You can install 

the Designer on one machine and the service on another if desired. 

Installing IQforms Designer 

 
To install the IQforms Designer, double click the “Designer.msi” file. 

 

 

 
The License Agreement will appear. Select the checkbox for “I accept the terms of the License 

Agreement” and click “Install” 
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The IQforms Designer will begin to install. 

 

 
 
 
Click Finish when the setup is complete. 
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Installing the IQforms Service 

 
To install the IQforms Service, double click the “Service.msi” file. 

 

 

 
The License Agreement will appear. Select the checkbox for “I accept the terms of the License 

Agreement” and click “Install” 
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The IQforms Service will begin to install. 

 

 

 
Click Finish when it is complete 

 

 

 
NOTE:  If the IQforms Service is not installed on the ImageQuest Server, you will need to change the 

IQServer value in the “Informa.ImageQuest.IQforms.Service.exe.config” from the setting of 

“localhost” to the actual ImageQuest Server name. This file is located on the computer where the 

Service was installed. The default location is C:\Program Files (or x86)\Informa 

Software\ImageQuest\IQforms\Service. 
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Once both installs have completed, there will be an entry in the All Programs Menu for IQforms under 

the Informa Software folder listing the IQforms Console and IQforms Designer. 

 

 

 

 

The installation of both programs creates 3 folders (Console, Designer and Service) in the Informa 

Software directory on the C: drive: 

In the example below, the location is C:\Program Files (or Program Files (x86)\Informa 

Software\ImageQuest\IQforms. 

 

 

 
The IQforms service is installed under the Windows Services section and defaults to the Local System 

account. 
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Form Set 
 
A Form Set will need to be created for each form or group of forms that will be used with IQforms. The 

purpose of a Form Set is to define a collection or "set" of forms and the common properties for those 

forms for use in processing images against the form set. The Form Set is the top of the hierarchy and 

contains one or more forms. 

Create a Form Set 

 
To begin designing a Form Set, open IQforms Designer. The FormAssist dialog will appear. Select “Create 

a new form template library” and click “OK”. 

 

 

IQforms Designer is started and a NewFormSet.frs is created. “frs” stands for “Form Recognition Set”. 
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Rename a Form Set 

 
To start, change the name of the Form Set to something meaningful or related to the form or group of 

forms that will be part of the Form Set. 

There are two ways to change the Form Set name. In the examples below, the Form Set is renamed to 

“Accounts Receivable”. 

Option 1 - Select “NewFormSet” in the Form Set tree view, type in the new name and press Enter. 

 

 

 

 
 
 
Option 2 – In the Settings window under the General tab, highlight “NewFormSet”, type in the new 

name and press Enter. 
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When the name is changed in the Form Set tree view or Settings window, it will automatically update in 

the associated field in the other section.  

 

 

 

Settings - General Properties 
 
The General tab in the Settings window contains multiple settings that must be configured for the Form 

Set. These options are highlighted red in the screenshot below. See the next page for descriptions and 

examples of each setting. 
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Cabinet - Indicates the name of the ImageQuest cabinet for the Form Set. This is where the form images 

will be archived by IQforms.  

NOTE: If you have multiple cabinets, select the appropriate cabinet from the dropdown list. 

 

 

 
Failure Queue - The “Failure Queue” is the Indexing Queue of an ImageQuest User or Role in IQdesktop 

that will contain any scans/forms that fail to process correctly. These failed scans/forms can be reviewed 

from the Indexing Queue and then corrected and manually indexed. 

 

 

 
Folder Path - Where the scans for this particular Form Set will be sent needs to be mapped in the 

“Folder Path” field. Each FRS must have its own, unique Folder Path. NOTE: If this Folder Path is not local 

to the IQforms Service, the Service account must be changed to an account with proper rights to 

read/copy and delete from that location. 

 

 

 
Field Minimum Confidence - This sets a minimum confidence for a successful match. If the best match 
for the field has a confidence lower than this value, this field will never consider it a match and no data 
will be read from the field. The default value is “0”. 
 
Enable Nonforms – Selecting this checkbox will group documents that are scanned together and not 

defined as a form into one multi-page document. This can be useful when scanning forms that have 

attachments. 

 
Disable Key Field lookup – Check this option if there is a Key Field lookup configured in ImageQuest and 

you want IQforms to ignore that lookup. By default, IQforms can work in conjunction with an ODBC 

lookup in ImageQuest (see the ImageQuest Administrator’s Guide for more information) to lookup data 

from an external source and populate additional attributes or fields as necessary.   
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Disable Key Field lookup has three associated options. All three options can be selected, or each option 

can be selected individually. 

Overwrite recognized field values with lookup values – IQforms reads the field data but will overwrite 

the field(s) with the lookup data regardless of what is read off of the form. 

Fail form when lookup returns zero results – This option tells IQforms to send the scanned document to 

the Failure Queue for manual indexing if there are no results returned from the lookup. 

Fail form when lookup returns more than one result - This option tells IQforms to send the scanned 

document to the Failure Queue for manual indexing if there are multiple results returned from the 

lookup. 

 

 

 

Notice that by checking the “Disable Key Field lookup” option, the associated checkboxes are grayed 

out. 
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The example below shows the general settings for the Accounts Receivable Form Set.  
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Settings - ScanFix Xpress Properties 

 
These properties allow you to set the image operations for all forms that are processed against the 
selected Form Set. 
 
The screenshot below displays the default settings. 
 

 

 

For more information about the Form Set ScanFix Xpress properties, please select Help > Contents in 

IQforms Designer. 
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Settings - Identify Properties 

 
Setting the Identify properties appropriately for a Form Set may improve the accuracy and speed of 
forms processing operations. 
 

The screenshot below displays the default settings. 

 

 

 
For more information about the Form Set Identify properties, please select Help > Contents in IQforms 

Designer. 
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Form Design 
 
Once the Form Set is created, the next step is to add, design and configure a new form template. 
 

Adding a Form to a Form Set 
 
A form is created from a tiff image that is imported into IQforms Designer. The recommended 

specifications for these images is Black & White, 300DPI using CCIT Fax 4 compression. The image should 

be free of any data that can change from form to form. In other words, remove all data on the form 

except for items that are constant like headers, addresses, field names, etc. See the screenshot below 

for an example. 
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To add a form to a Form Set, click on the “Add Form to Form Set” icon on the toolbar. 

 

 

 
You will be prompted to select a new form image. Select the tiff image that will be used to create the 

new form template. In the example below, the “Invoice – Blank” TIFF image is selected. Click “Open” to 

add the image to the Form Set. 
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When the image is imported, the Form Set is updated as shown in the example below.  

The image will be displayed on the right-hand side. In the Form Set tree view, a form item with the name 

of the selected image is added below the Accounts Receivable Form Set. The Settings window will 

change to show the General settings for the form template. 
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Rename a Form 

 
Select the image name in the Form Set tree view, type in the new name and press Enter. In the example 
below, the image name is changed to “Invoice”. 
 

  

 

 

 
 
The Form field will update to reflect the name change and as will the associated Form field in the 
General settings tab. 
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The ImageQuest Document Type that will be assigned to the form template must be selected. In the 

example below, “Invoice” is selected from the list.  

 

 

 

NOTE: The Document Type must already exist in ImageQuest in order to select it from the Document 

Type list. Also, the ImageQuest attributes should match the field names on the template. 

Settings – General Properties 

 
Some of the additional options available under the General tab include: 

Document Group - Select this option to assign all the forms to a certain Document Group in 

ImageQuest. For more information on Document Groups, see the ImageQuest Administrator’s Guide. 

Field Minimum Confidence - The minimum recognition setting for a field. This is the minimum setting 

for IQforms to recognize the data in the field. The default value is “0”. 

Needs OCR - Select this option to process the form in ImageQuest’s OCR process. This option allows for 

tiff’s to be converted to PDFs and full text extraction to be performed for keyword searches. PDFs are 

also processed in OCR, however, they remain in PDF format and also have full text extraction performed 

on them for keyword searching. For more information on the ImageQuest OCR process, please see the 

ImageQuest Administrator’s Guide. 

Multiple Page Field - This value is used if there are 2 or more pages to a form with a common field on 

both. For example, if the same Invoice Number is on both page 1, 2, 3, 4, etc. IQforms will recognize 

those pages as one document and continue until it encounters the next unique Invoice Number and 

start a new document. 

Static Values - This feature allows the form to always have certain values for each attribute. This only 

applies to form fields. Static values are attributes in ImageQuest. See page 22 for more information on 

Static values. 
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In the example below, the following options are configured: 
 

• Document Group “ORLANDO” is selected from the list 

• Needs OCR is checked 

• Multiple Page Field is checked and “InvoiceNumber” is selected from the list 

• “Paid” is selected from the Static Values list 
 

 

 
See the next page for more information on using Static Values. 
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Static Values 

 
Static Values apply to fields that will always have the same value when processed by IQforms. Static Values 

can apply to an actual field on the form or a field that is not on the form. In either case, the Static Value 

field must exist as an attribute in ImageQuest. 

For example, the Invoice form should always have a field called “Paid” and the default or static value 

should be “False”. The form itself will not have a field called “Paid”. 

In the example below, the ImageQuest True/False attribute “Paid” is selected and the True/False checkbox 

is displayed. The checkbox is left unchecked so the default value will be “False”. 

 

 

 
Click          to add Paid to the Static Values list. 

 

 
 

With this configuration, every Invoice form processed by IQforms will include the “Paid” attribute and 
the value will be “False”. The value can be changed to “True” in ImageQuest any time after IQforms has 
processed the form. 
 
Another example could be Vendor Number. If the Invoice forms being processed all pertain to the same 
Vendor Number, Vendor Number could be added as a Static Value  
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The ImageQuest Text attribute “Vendor Number” is selected from the list and “12345” is typed into the 
entry field.  
 

 

 
 

Note: to clear the value in the entry field, click the undo button as highlighted below. 

 

 
 

Click          to add Vendor Number to the Static Values list. 
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To remove a Static Value from a form, click the         on the entry to be removed. In the example below, 
“Vendor Number” is removed from the form. 
 

 

 
Now “Paid” is the only Static Value for the form. 
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Adding Fields to a Form 

 
Next, determine which form fields you would like to retrieve data from on the form. 

OCR Tool 

 
In this example, we are using the OCR tool to read the machine printed values for INVOICE NUMBER, 

INVOICE DATE and SHIP TO fields.  To define these fields in IQforms Designer, select the OCR Tool icon 

on the toolbar: 

 

 

 
The cursor will change to a “+” sign once you drag it over the template image.  

 

 

Select the area you would like to read data from by left-clicking and dragging the cursor around the 

field. The field will be highlighted in blue as shown here: 
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Release the mouse and the field will be selected as shown below. 
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A new field item called “Field 1” is added to the form item in the Form Set tree and the form Settings 

window reflects the options for configuring the form field. 

See below for example and information about options available in the General tab. 

 

 

 
Field – The name of the form field 

Field Minimum Confidence - The minimum recognition setting for a field. This is the minimum setting 

for IQforms to recognize the data in the field. The default value is “0”. 

Regular Expression - Used to help improve data recognition for fields that have a specific format 

Location and Size – Location and size of the field on the form 
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Rename a Form Field 

 
Change the name of a Form Field to an ImageQuest Attribute name related to the data to be captured. 

There are two ways to change a form field name. In the examples below, the field name is renamed to 
“InvoiceNumber”. 
 
Option 1 - Select “Field1” in the Form Set tree, type in the new name and press Enter. 

 

  
 

 

 
Option 2 – In the General tab, highlight “Field1” and begin typing in the name. The list of available 

ImageQuest attributes will appear. Select the correct attribute for the field name. In the example below, 

the letter “I” is entered and the list of attributes beginning with the letter “I” are displayed. 
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When the name is changed in the Form Set or Settings window, it will automatically update in the 

associated field in the other window.  

 

 

 

Regular Expression 

 
A Regular Expression can be used to help improve data recognition for fields that have a specific format. 

From example, the InvoiceNumber should be all digits and only 6 characters in length. In the example 

below, the Regular Expression entered is [0-9]{6}. For more information about Regular Expressions and 

how to configure them, see www.regexlib.com for more information. 
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Location & Size – These are the values that represent the location and size of the OCR, OMR or ICR field 

that have been defined on the form. These can be changed manually by selecting the value and 

changing it. 

 

 

Settings – ScanFix Xpress 

 
Choose the ScanFix Xpress properties that you want to be processed on the field after dropout occurs. 
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For more information about the ScanFix Xpress field properties, please select Help > Contents in IQforms 

Designer. 
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Settings – Dropout 

 

Dropout is a process by which the pre-printed content on an image is removed, leaving only the data 
that was added to a form. When filled data and template data overlap, the filled data will be 
reconstructed as accurately as possible. 

 

 

 
For more information about the Dropout field properties, please select Help > Contents in IQforms 

Designer. 
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Settings – OCR 

 
OCR (Optical Character Recognition) is the process of converting machine printed information into 

editable text. Below are the default settings: 
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Character Set 

 
The Character Set list contains commonly used formats that, depending on the selection, can help 

improve data recognition. 

For example, the data for InvoiceNumber will be digits, like “123456”. To improve recognition for 

InvoiceNumber, “Digits” is selected for the expected Character Set. IQforms will expect this field to have 

characters in the range of 0 – 9 and any combination of those characters. 

 

 

 
If the InvoiceNumber format was “INF12345”, the “Custom…” Character Set would be useful. The next 

few pages provide an example of how the Custom option could be configured. 
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Select Custom and then click Edit. 

 

 

 
The Edit Custom OCR Character Set dialog opens. 
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Select “All Alphas” and click “Uncheck”. 

 

 

 
Note: You can also right-click on a group of characters to access this option. 

 
All Upper Case Alpha and Lower Case Alpha characters are unchecked. 
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Check the boxes for “I”, “N” and “F” since these characters are expected to be present for the 

InvoiceNumber value. 

 

 

 
Right-click on the Punctuation group and select “Uncheck All “Punctuation””. 
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All Digits should remain checked. Right-click the Currency Symbols and Arithmetic Symbols groups to 

uncheck all. 

 

 

 
Click “OK” to return to the OCR tab. With this Custom configuration, IQforms will expect to see 

InvoiceNumber values in the following format: “INF#####”. 
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Field Type 

 
Field Type provides options for commonly used data formats such as Currency, Date and Social Security 

Number to help improve recognition. For example, if the expected data is a phone number, you could 

select “United States Phone Number” for Field Type and IQforms would expect to see a format like (123) 

456-7890. 

In the example below, “General Text” is selected for the InvoiceNumber field since it best matches the 

data expected in that field. 

 

 

 
For more information about the OCR field properties, please select Help > Contents in IQforms Designer. 

Note: The tabs at the form level apply to the entire page. Tabs at the field level apply only to that 
field. 
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Other Field Options 

 

Resize a Field 

NOTE: To resize the Ocr fields, select the  icon and click on the field you want to resize. Drag the 

black squares as needed to resize the field. 

 

 

Zoom in on a Field 

 
To zoom in on a certain field on the form, select the field on the form or in the field list and click the 

“Zoom In” button on the Forms Designer toolbar. In the example below, the BILL TO field is selected. 

 

 

 
Click Zoom In 
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Now the BILL TO field in zoomed in so it’s easier to see and modify as desired. 

 

 

 

 

 

Delete a Field 

 
To delete a field from the form, select the field on the form or in the field list and press the Delete key or 

click the “Delete” button on the Forms Designer tool bar. 

In the example below, the BILL TO field is selected. 
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Press the Delete key or click the Delete  

 

 

 

Click “Yes” to confirm and delete the field from the form and the field list or “No” to retain the field. 

Note: The Delete button can also be used to delete a form from a Form Set. 
 
Continue to add and configure additional form fields as needed. In the example below, the InvoiceDate 

and VendorName fields have been added to the form. The arrows show the relationship between the 

fields in the field list and their respective locations on the form. 
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Saving a Form Set 

 
Any changes that are made to a Form Set should be saved. Notice that after making changes to the 

below template, an asterisk shows appears after the file name in the title bar. This means that the Form 

Set has changes that need to be saved. 

 

 

 

 

 

 
Click “Save Form Set” in the Forms Designer toolbar. 

 

 

 
Note: Save Form Set is also available from the File menu or by pressing Ctrl+S. 

 

The “Save Form Set As” dialog will open as shown below. 

Browse to a location to save the Form Set and enter a File name for the Form Set. In this example, the 
File name is changed to “Accounts Receivable” 

Click “Save” to save the Form Set. 
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When a Form Set is saved, a FormAssist folder and a .frs file are created using the FormSet name. 

 

 

The FormAssist folder contains the .frd file (or Form Definition File) which is the actual form template 
with the name of the image file that was used to create the form. 

 

 

A Form Set can be saved anywhere, but it is recommended that you create a new folder called Formsets 
in the IQforms directory. By default, this location is C:\Program Files (or Program Files (x86))\Informa 
Software\ImageQuest\IQforms. 
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Testing a Form 
 
IQforms Forms Designer provides the ability to test a form to see how IQforms reads the data from the 

fields that were configured. To test a form, you must have a TIFF or PDF image that matches the form 

layout that has data for the fields that IQforms will recognize. When using a TIFF image, the image 

properties must match the properties of the TIFF that was used to create the form.  

The Invoice example below will be used for testing. 
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In IQforms Forms Designer, click the “Process Forms” button on the toolbar. 

 

 

 
Browse to and select the test file. Click Open to launch the Process Forms window. 
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Process Forms 

 
The Processing tab shows the progress of the IQforms process as it reads the original image, enhances 

the image for processing, identifies which form matches the image and then aligns the original image to 

the form. 
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Identification Statistics 

 
The Identification Statistics tab lists the full results from the filled image identification process. This 

includes the list of template images in the Form Set and the corresponding filled image identification 

confidence values for each form at each considered rotated orientation. Rotations that were not 

considered during identification are left blank. 
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Field Results 

 
The Field Results tab shows the results of the data recognition for each field that is configured on the 

form. 

In the example below, the result returned for InvoiceNumber is “868470” as shown in the Results box. 

The Text Block Result section shows the confidence level on this field was at 98%. This means that 

IQforms was 98% confident of the data it read. 
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The InvoiceDate and Vendor Name fields were returned with the correct values as shown below and the 

Confidence levels are 86% and 78% respectively. 
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Timing Results 

 
The Timing Results tab provides information related to the filled-in form processed against the Form Set. 

It lists the image actions performed, filled-in form duration, success status, total duration, average 

duration, the number of filled images processed, and the number of filled images identified. 

 

 

 
Note: Only one image can be tested at a time. Multi-page documents can be tested but the test 

process in Designer only reads the first page. The multi-page document would have to be broken 

down into individual 1-page scans in order to read additional form scans in that particular document. 

Once the test is complete, click “Exit” to close the Process Forms window. If you are not satisfied with 

the results, you can modify the Field settings and test the image again. For example, if the InvoiceDate 

read as “O1%01/12” and the actual value is “10/01/12”, you may want to modify the ScanFix Xpress or 

OCR settings for that field and then save the Form Set and test the image again. 
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Add Form Set Configuration 
 
Once a Form Set has been created and saved, it will need to be added to the IQforms Configuration 

before it can be used in production. 

To start, open the IQforms Console. 

 

 

 
Click Edit Configuration in the IQforms Console to open the IQforms Configuration window. 
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The IQforms Configuration window allows users to add configurations for Forms, Barcodes and Checks. 

Click “New” to open the Mode Properties dialog. 

 

 

 
Mode Properties defines the properties for a particular Form Set. 

Click the FormSet Path ellipsis to select the Form Set .frs file. 

 

 

 

Browse to the location of the Form Set to be configured, select the .frs file and click “Open”. 
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In the example below, the Accounts Receivable.frs file is selected. 

 

 

 
Once the FRS file has been selected, the path will show in the FormSet Path section. Click “Save”. 

 

The Mode Properties window will close and IQforms Configuration will display the Form Set 

configuration to include the Form Set FailureQueue and FolderPath for the selected .frs. 
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The “isValid” column indicates that the FRS file can be read without error and is not corrupt. 

 

 

 
Click the X to close the IQforms Configuration. 

To delete or edit an existing IQforms Configuration, select the configuration in the list and click Delete or 

Edit. 

NOTE: Any changes that need to be made to an IQforms Configuration or Form Set file require 

restarting the IQforms Service in order for those changes to take effect. 
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Processing Forms 
 
The IQforms Service must be running so it can poll all configured Folder Paths for new images to be 

imported and processed by IQforms. 

For this example, the invoice below will be scanned to C:\AR Reports as INVOICE Scan1.tif. 

 

 

 
IQforms should identify the image as the Invoice form and read the data for the following fields: 

INVOICE NUMBER, INVOICE DATE and the first line for BILL TO. 
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The IQforms Console window allows users to monitor scans that are being or have been processed. The 

IQforms console window continuously logs what items it is processing and it can also be used to 

stop/start the IQforms service and edit IQforms configurations. The IQforms Console does not need to 

be running in order for IQforms processing to occur. 

When files are processed through IQforms, the IQforms Console will show the progress. The progress for 

INVOICE scan1.tif is displayed in the example below. 

 

 

 
The progress information will include how many forms were processed from the image, how many 

documents were created from the image and how many documents were saved to ImageQuest. The last 

status shows “Processing complete for C:\AR Forms\INVOICE scan1.tif”. 

Based on the information provided, processing for the INVOICE scan1.tif was successful. 

The file was processed successfully and sent into ImageQuest as an Invoice document with the data 

from the three fields that were configured on the form: InvoiceNumber, InvoiceDate, and Vendor. 

 

 

 
If “Need OCR” was enabled for the form, the IQ Ocr and Fulltext service will extract any readable text for 

keyword searching and convert the .tif file into a Searchable PDF. 
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If an image cannot be processed due to an issue with form identification, the progress information will 

indicate that the batch has failed because it contains unrecognized forms and it has been saved into the 

IQ exception queue for verification. 

 

 

 

All IQforms exceptions will be added to the Failure Queue that was configured in the Form Set. 

Items added to the Failure Queue will appear in the Indexing Queue of the ImageQuest User or Role that 

was configured for the Failure Queue. 

In the example below, the batch was saved to the ImageQuest Administrator’s Indexing Queue as 

Document Type “MFP Scan”. 
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When the batch is opened in Indexer, the image scanned does not match the layout of the Invoice form. 

Assuming this particular image was scanned by mistake, the user could delete the batch from the 

Indexing Queue and rescan the proper image for IQforms. 
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If an image cannot be processed due to an issue with field recognition, the progress information may 

indicate a warning that the image was recognized as a form but it requires verification. 

In the example below, IQforms recognized INVOICE scan3.tif as an INVOICE form but something about 

the form requires verification. 

 

 

 

All IQforms exceptions will be added to the Failure Queue that was configured in the Form Set. 

Items added to the Failure Queue will appear in the Indexing Queue of the ImageQuest User or Role that 

was configured for the Failure Queue. 

In the example below, the batch was saved to the ImageQuest Administrator’s Indexing Queue as 

Document Type “MFP Scan”. 

 

 

 

 

 

 

 

 

 



  
  IQforms 15.7 User’s Guide 

64 
 

When the batch is opened in Indexer, the user can review and confirm what data fields could not be 

read properly by IQforms. 

In the example below, the “Invoice” Document Type is already assigned which indicates IQforms was 

able to identify the form properly. IQforms was also able to recognize “Big Corp.” for the Vendor field. 

InvoiceNumber and InvoiceDate are flagged with a red x  that indicates a problem with these fields. 
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The user can mouse over the red x to get an error description. 

In the examples below, IQforms tried to read the value for INVOICE NUMBER and INVOICE DATE but it 

wasn’t confident with the results. 

 

       

 
 

 

 

 

 

If the user looks at those fields on the actual form image, it is obvious that the data is nearly unreadable. 
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If the user is able to interpret or acquire the correct data, they can key it in and click “Commit” to add 

the Invoice document to ImageQuest. 

 

 

 

NOTE:  It is highly recommended to test any IQforms forms or barcode process before going live – 

Scan what you plan to scan for each FRS or barcode configuration and confirm you’re getting the 

proper results. If you do not, please contact support for help. 
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Other Recognition Types 
 

ICR 
 
ICR (Intelligent Character Recognition) is the process of converting hand printed information into 

editable text. 

The steps for adding and configuring an ICR field are almost identical to the steps to configure an OCR 

field. 

In the example below, a Form Set called “Surveys” is created and a Customer Survey form has been 

imported. The following fields will require hand written entry: First Name, Middle Initial, Last Name, and 

Email Address. 
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To begin creating the ICR fields, click the ICR Tool in the Forms Designer toolbar. 

 

 

 
In the example below, the mouse is placed at the top left-hand corner of the First Name field. 

 

 

 

The mouse is dragged to the bottom right-hand corner of the First Name field to select the field. 
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Repeat these steps until all four fields have been highlighted as seen below: 

 

 

 
The ICR settings tab shows the default settings below. 

 

 

 
For more information about the ICR field properties, please select Help > Contents in IQforms Designer. 

When IQforms processes the Customer Survey form, it will read the handwritten data in the configured 

fields and apply the defined ICR settings for recognition. 
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OMR 

 

OMR (Optical Mark Recognition) is a technique for collecting information on a form where the user can 

mark response positions to indicate their answers to questions rather than having to write them out. 

For example, a form may question sections with checkboxes or bubble fields as shown below. 

 

 

 
Select the OMR Tool from the Forms Designer toolbar. 
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Highlight the top left corner of the check box and drag the mouse to the bottom right corner to select 

the field.  

 

 
 
The field is added to the field list as shown below. 
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The Field name is changed to “1-4 Years” which is also an Attribute in ImageQuest. The Data Type for 

the ImageQuest Attribute is True/False, so if the field is selected on the form, the attribute will be 

checked as “True” in ImageQuest. 

 

 

The OMR ScanFix Xpress and Dropout tabs are very similar to same tabs for OCR and ICR. 

The default settings for OMR tab are shown below.  
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Some of the additional options available under the OMR tab include: 

Analysis Comparison Method - This value specifies if the FormFix OMR engine used by FormAssist 

performs image comparison processing. Requesting comparison will improve recognition and accuracy 

in most cases, at a moderate cost to speed. 

Bubble Shape - This value specifies the geometric shape of the bubbles in the OMR field to be analyzed. 

Marked Bubble Threshold - This value specifies a percentage between 0 and 100 that one or more 

bubbles in a field must exceed in normalized mark density before the field is considered to contain a 

marked bubble. 

Unmarked Segment Result - This value specifies a result character value for a field's segment that was 

determined to have no bubbles marked. 

Single Checkbox Field - Enables controls for configuring a field that will have a single segment with a 

single bubble location. 

Below is an example of how multiple OMR would appear in the field list. 
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Multiple Checkbox Field 

OMR can also allow multiple checkboxes to be used. 

In the example below, there are multiple checkboxes in the field. 

Highlight the top left corner of the field on the form and drag the mouse to the bottom right corner to 

select the entire field.  

 

Click the OMR tab to configure the field. Select Multiple Checkbox Field to enable the Multiple Checkbox 

Field options. 
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Determine if the field allows single or multiple choice and select the appropriate option from the Marks 

Permitted. 

Select the Segments Editor to open the OMR Segment Bubble Value Editor and configure IQforms to 

match the multiple checkbox field. 

 

 

 
In the example below, the Segment Count (top columns) shows five segments and the Bubbles per 

Segment (rows going down) is set to 10. This configuration matches the checkboxes and bubble fields 

for the Promotion Code field.  
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You can change the values in Segment Editor to match the values of the actual field being read. 

As shown below, Bubble 10 shows a value of “0” which matches the actual field value. Select “Fill Right” 

to copy the same value to the other 4 segments. 
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Below are the results of the changes made. 

 

 

 
Click “OK” to close the OMR Segment Bubble Value Editor. 
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The settings for the highlighted fields are the defaults for the formatted field. 
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When the configuration is complete, IQforms Designer would look similar to the example below. 
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The example below shows a completed survey form image. This image will be used to test the Customer 

Survey form with Process Forms. 

 

 

 
The next few pages show the results of the Process Form task. 
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Identification Statistics 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 



  
  IQforms 15.7 User’s Guide 

82 
 

 
See below and following pages for screenshots of the Field Results for each form field. 
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Once testing is complete, the Surveys Form Set can be added to the IQforms Configuration via the 

IQforms Console. 
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See below for an example of a Customer Survey form successfully processed by IQforms and the results 

in IQdesktop. 

 
IQforms Console. 

 

 

 
Results in IQdesktop. 

 

 

 

The example below shows the status of a Customer Survey form that identified properly, but there was 

a recognition issue with one of more fields on the form. 

 

 

 
This form will be added to the assigned User or Role Failure Queue (Indexing Queue) for review and 

correction. 
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In the example below, the batch is opened in Indexer and the Document Type is assigned correctly, but 

two fields, First Name and Last Name, need review. 

 

 

 
A closer look at the image shows that the first boxed for the First Name and Last Name did not scan 

clearly. If the user can interpret the correct values, they can correct the data for each field and commit 

the document to ImageQuest. 

 

 
 
NOTE: It is highly recommended to test any IQforms forms or barcode process before going live – Scan 

what you plan to scan for each FRS or barcode configuration and confirm you’re getting the proper 

results. If you do not, please contact support for help. 
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Barcode Coverpages 
 
IQforms is also designed to read barcodes from coverpages for scanning. Barcodes can be useful for 

reading data, such as Invoice Numbers, to then perform a lookup against an external source and 

populate that data into ImageQuest. (See the IQAdministrators Guide for further information on 

configuring lookups). 

IQforms supports four types of barcode images: PDF417, Code 128, Code 39 and QRCode. 

To enable barcode scanning in IQforms, select the Edit configuration icon in the IQforms Console to 
open the IQforms configuration screen: 

 

 

 
Note that the previously configured forms configuration for Accounts Receivable is listed: 

Click New. 
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From the Mode Properties dialog, select the dropdown for Mode and choose Barcode Coverpages. 

 

 

 
Note: The cabinet name will populate the first cabinet in alphabetical order that is configured on your 

ImageQuest Server. For example, if your ImageQuest cabinet was called Account Payable, that value 

would show in the cabinet name by default. 
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Select the User or Role for the Failure Queue. Any documents that fail to be read correctly will be sent to 

the ImageQuest Indexing Queue designated here. 
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Next, select the folder path where the barcode scans will be sent in order for IQforms to process them.   

Note: The Barcode folder cannot be located in the same folder as a Forms folder. 
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Enable Nonforms: Selecting this checkbox will group documents that are scanned together and not 

defined as a form into one multi-page document. This can be useful when scanning forms that have 

attachments. 

 

 

 

 

 

 

 



  
  IQforms 15.7 User’s Guide 

97 
 

Attribute Lookup Settings provides options for if and how IQforms will use an Attribute Lookup for a 

barcode coverpage. 

 

 

 
Disable Key Field lookup – Check this option if there is a Key Field lookup configured and you want 

IQforms to ignore that lookup. 

Disable Key Field lookup has three associated options. All three options can be selected or each option 

can be selected individually. 

 

 

 
Overwrite recognized field values with lookup values – IQforms reads the field data but will overwrite 

the field with the lookup data. 

Fail form when lookup returns zero results – This option tells IQforms to send the scanned document to 

the Failure Queue for manual indexing if there are no results returned from the lookup. 

Fail form when lookup returns more than one result - This option tells IQforms to send the scanned 

document to the Failure Queue for manual indexing if there are multiple results returned from the 

lookup. 

Notice that by checking the “Disable Key Field lookup” option, the associated checkboxes are grayed 

out. 
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After the Mode Properties are configured, click “Add” to open the Coverpage Edit screen to configure 

the settings for the coverpage. 
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The Coverpage Edit dialog defines the main configuration for a barcode coversheet that will be 

processed by IQforms using the following settings: 

Name: The name of the coverpage. For example, “Invoice Coversheet”. 

Discard Coverpage: Checking this box will prevent the coverpage from being sent into ImageQuest. All 

pages behind the coverpage will be sent into ImageQuest. 

Needs OCR: If checked, the coverpage and/or associated documents will be processed by OCR 

Document Type: The ImageQuest Document Type that the scans will be indexed under. 

Regex Capture Name: The name of the capture group to be used in the Regular Expression. 
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The example below shows entries or selections for a New Employee Packet. The Regex Capture Name 

reflects what information is expected to be captured from the barcode. 

Click “New” to open the Barcode Edit dialog. 
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In the Barcode Edit dialog, enter the IQ Attribute Name that will be associated with the Barcode. Then, 

enter the Expression for that particular barcode. 

An expression is a special text string for describing a search pattern or identifying patterns in text.  

 

 

 
In the example below, “First Name” is entered for IQ Attribute Name and the Expression entered is 

(?<Capture>[^;]*);[^;]* which will parse the barcode string and capture the First Name value from a 

semicolon delimited string of values. 

 
See page 115 for more information about Expressions and additional examples. 

 

 

 
Click “Save” to save the barcode definition and return to the Coverpage Edit window. 
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In the example below, there is now a new barcode definition listed in the Barcode section for First Name 

that also displays the Expression that was configured. 
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Barcode definitions can edited or deleted as needed. To edit or delete a barcode definition, right-click 

on the definition and select Edit or Delete. 

 

 

 
Edit will open the Barcode Edit dialog. 

Delete will prompt the user to confirm they want to delete the selected barcode definition. 

 

 

 
Click “Save” in the Coverpage Edit dialog to return to the Mode Properties dialog. 
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In the example below, there is a new coverpage configuration entry in the Coverpages section that 

reflects the New Employee Packet that was configured in the Coverpage Edit dialog. 

 

 

 

 

 

 

 

 



  
  IQforms 15.7 User’s Guide 

105 
 

Coverpage configurations can edited or deleted as needed. To edit or delete a coverpage configuration, 

right-click on the configuration and select Edit or Delete. 

 

 

 
Edit will open the Coverpage Edit dialog. 

Delete will prompt the user to confirm they want to delete the selected coverpage configuration. 
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Click “Save” to save the Barcode Coverpage configuration. 
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In the example below, the new Coverpages configuration is listed in IQforms Configuration and now the 

New Employee Packet can now be processed by IQforms. 

 

 

 
Click the X to close the IQforms Configuration. 

 
When IQforms processes a barcode coverpage, it will read the barcode(s) and populate the associated 

attribute(s) with the barcode data and import the coverpage and/or attached documents as the 

Document Type that was assigned in the coverpage configuration. 
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A Barcode Coverpage configuration can have multiple coverpages and barcode definitions. 

In the example below, a new barcode definition will be added to the New Employee Packet. 

First, Edit is selected on the New Employee Packet coverpage configuration to open the Coverpage Edit 

dialog. 
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Click “New” to open the barcode Edit dialog. 

 

 

 
In the example below, “Last Name” is entered for IQ Attribute Name and the Expression entered is 

[^;]*;(?<Capture>[^;]*);[^;]*[^;]* which will parse the barcode string and capture the Last Name value 

from a semicolon delimited barcode string. 

Click “Save” to save the barcode definition and return to the Coverpage Edit window. 
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In the example below, there are now two barcode definitions listed in the Barcode section, one for First 

Name and the newly added definition for Last Name. 
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Each new barcode definition that is added will be listed in the Barcodes section. In the example below, a 

third definition for Date of Birth has been added and is displayed in the Barcodes section. 

 

 

 
Click “Save” to save the Coverpage Edit and return to the Mode Properties dialog. 
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Click “Save” to return  
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Click the X to close the IQforms Configuration. 

 

 
 

The New Employee Packet can now be processed by IQforms. 
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The example below shows a New Employee Packet coversheet and associated pages: a copy of a 

resume, W-4 and a Driver’s License and Social Security Card. The barcode on the coversheet contains 

the data for the following: First Name, Last Name and Date of Birth. 

When IQforms processes this document, it will parse the barcode and capture the data for First Name, 

Last Name and Date of Birth and add the document to ImageQuest as a four page New Employee Packet 

and populate the First Name, Last Name and Date of Birth fields with the barcode data. 
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The New Employee Packet is scanned to C:\Barcode Coversheets. The example below shows the 
progress in the IQforms Console. 

 

 

 
The example below shows the results in IQdesktop. 

 

 

 
All IQforms exceptions will be added to the Failure Queue that was configured in the Form Set. 

 

NOTE: It is highly recommended to test any IQforms forms or barcode process before going live – Scan 

what you plan to scan for each FRS or barcode configuration and confirm you’re getting the proper 

results. If you do not, please contact support for help. 
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Below are some examples of how to configure an Expression: 

Example 1: 
  
The following Expression will capture a barcode that contains a 10 digit number: 
  
(?<Capture>^[0-9]{10}) 
  
Breakdown: 
  
• Regex to capture 10 digits -  ^[0-9]{10} 
• ?<Capture> - Capture everything after this statement 
• Enclose the capture group in parenthesis before the question mark and after the regex statement 

  

Example 2: 
  
The following Expression will capture a barcode that contains a 10 digit number in between a static INF 
prefix and a suffix of a dash followed by 4 alpha characters: 
  
Example string:  INF01234-ARIZ 
  
INF(?<Capture>[0-9]{5})-\w{4} 
  
Breakdown: 
  
• Regex to capture the literal value - INF 
• ?<Capture> - Capture everything after this statement 
• Regex to capture 10 digits -  [0-9]{5} 
• Enclose the capture group in parenthesis before the question mark and after the regex statement 
• Hyphen character captures the dash 
• Regex to capture the last 4 characters - /w{4} 

 

For more information on Regular Expressions, see the website below:  

http://www.regexlib.com 
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Check Recognition 
 
IQforms is also designed to work with A2iA to perform check recognition. To enable check recognition in 

IQforms, select the Edit configuration icon in the IQforms window to open the IQforms configuration 

screen. 

 

 

 
Select New: 
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From the Mode Properties screen select the dropdown for Mode and choose Checks: 

 

 

 
As with prior configurations (Forms & Coverpages), the cabinet that is listed first will populate in the 

Cabinet name field: 
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Select the user or Role for the Failure queue. Any documents that fail to be read correctly will be sent 

here. 
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Next, select the folder path where the checks will be sent in order for IQForms to process them. The 

folder path must be unique. 

Select the checkbox for “Enable Nonforms” if other scans in addition to checks will be scanned along 

with checks. 

 

 

 
Note: For the following section of the Checks configuration, A2IA Checkreader must be installed on 

the server that is hosting the IQforms service.   

A2iA requirements 

• USB Port 

• USB Dongle (Can be installed on a different computer) 

• Refer to A2iA documentation for more information 

Select the Params Path for A2IA: 

C:\Program Files\A2iA\A2iA CheckReader V4.4 R2\Parms\Int\Parms 

Next, select the Doc Table path for A2IA: 

C:\Program Files\A2iA\A2iA CheckReader V4.4 R2\Data\Checks\CFUS_AMT\US_AMT.tbl 
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Enter the Dongle Server Address and Document Type.  

Note: The Document Type must already exist in ImageQuest and must be set to Check.  

Note: the attributes that are captured are PayerName, CheckNumber, Date, MICR and Amount. These 

values are hardcoded and cannot be changed. 

Nonform Threshold defaults to 70. Anything above this threshold will recognize as a Check. 

Engine Timeout refers to how long A2iA will attempt to process the document before it fails it. The 

default is 10000 milliseconds. 

Image DPI is set to 200 by default.  

Note: The DPI setting MUST match the scanner setting or recognition will fail. 
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Click Save. The IQforms Configuration screen should look similar to this: 

 

 

 
Below is an example of a check that failed to read correctly because the confidence level on the 

CheckNumber and Date fields was too low. The user needs to index this check manually and verify the 

data is correct prior to committing the scan into ImageQuest. 
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When a check is successfully processed by IQforms, it is added to ImageQuest with associated check 

data as seen in the example below. 

 

 

 

NOTE: It is highly recommended to test any IQforms forms or barcode process before going live – Scan 

what you plan to scan for each FRS or barcode configuration and confirm you’re getting the proper 

results. If you do not, please contact support for help. 

Upgrading IQforms 
 
Before upgrading IQforms, we strongly recommend you backup your existing IQforms application files 

and all IQforms FRS files and associated FormAssist folders. 

If upgrading IQforms from version 11.2.1 or higher, the upgrade process is very simple.  Run 15.7 

designer.msi and service.msi to upgrade both the IQforms designer and the service. Nothing more needs 

to be done. 

 
If upgrading IQforms from a version earlier than 11.2.1, the upgrade steps are as follows: 

1. Make a backup of the existing IQforms application files (especially the Configuration XML file) 
and any FormAssist folders and FRS files. 

2. Run the IQforms 15.7 Service.msi 
3. In the newly created IQforms\Service folder, replace the new 11.3 Configuration XML with the 

Configuration XML that was backed up in Step 1 
4. Run the IQforms 15.7 Designer.msi 
5. Open IQforms 15.7 Designer 
6. Open all FRS files and setup all the Document Types and attributes 

7. Verify the IQforms Document Types and Attribute are mapped correctly in ImageQuest 
8. Add each FRS in the IQforms Configuration 
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Logfiles 
 
The IQforms Service logfiles are located on the PC that IQforms is installed on in the User’s Temp 

directory for the user that is running the IQforms service. The logfiles are used for troubleshooting 

purposes to give the user or Informa Engineer more details if an error occurs. In this example, they are 

located here: 

%appdata%\Local\Temp\Informa Software\LogFiles\IQforms 

 

 

 

If the IQforms service is running as the Local System user, the log files will be located under 

%windir%\temp\Informa Software\LogFiles. 

The IQforms Designer also has its own logging capabilities. To enable the logging for IQforms designer, 

launch the application and from the Tools menu select “Enable Component Debug Logging”. 

 

 

 
This log is saved in the default location. 

 

 


